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 ET-EASY168 STAMP เปนบอรดไมโครคอนโทรเลอรในตระกูล AVR8 ขนาดเล็กจ๋ิว โดยมีขนาด

ของบอรดเพียง 2cm x 5cm เทานั้น ซึ่งขนาดบอรด ประมาณเทากับตัวถังของไอซี 28 DIP 300 โดยเลือกใช

ไมโครคอนโทรเลอรตระกูล AVR8 เบอร ATmega168 ของ ATMEL เปน MCU ประจําบอรด โดยเลือกใช 

MCU ที่มีรูปรางตัวถังแบบ 32 TQFP พรอมวงจรรอบนอกที่จําเปนอยาง Oscillator และ Reset รวมไวดวย

ภายในบอรด นอกจากนี้แลวภายในตัวบอรดยังไดรวมเอาไอซี USB Bridge ของ FTDI เบอร FT232R เพื่อ

ใชติดตอส่ือสารแบบอนุกรมดวย RS232 กับคอมพิวเตอร PC ผานทางพอรต USB ไดโดยตรง 

 ทําใหบอรด ET-EASY168 STAMP เปนบอรดทดลองขนาดเล็กที่เพียบพรอมไปดวยวงจรพื้นฐานที่

จําเปนตอการใชงานไมโครคอนโทรลเลอรตระกูล AVR8 อยางแทจริง เพียงแตเสียบสาย USB จากพอรต 

USB ของเคร่ืองคอมพิวเตอร PC เขากับข้ัว USB ของบอรด ET-EASY168 STAMP ก็สามารถทําการเขียน

โปรแกรม และ Download Code ใหกับ MCU เพื่อทําการทดลองไดทันที  

 

คุณสมบัติของบอรด 
 เลือกใช MCU ตระกูล AVR8 เบอร ATmega168 ของ ATMEL Run ความถี่ 16.00 MHz  

o มีหนวยความจํา Flash สําหรับเขียนโปรแกรม 16KByte ถาใชการพัฒนาโปรแกรมผาน

ระบบ AVRISP หรือ 14Kbyte เมื่อใชการพัฒนาโปรแกรมผานระบบ Boot Loader RS232 

o มี SRAM ใชงานขนาด 1KByte และ EEPROM ใชงานขนาด 512 Byte 

o มี GPIO ใชงานจํานวน 22 บิต  

 Digital GPIO จํานวน 14 บิต 

 Analog Input (ADC) ขนาดความละเอียด 10บิต จํานวน 8 ชอง 

 ใชงานกับแรงดันไฟตรงขนาด +5VDC โดยใชไดทั้งกับแหลงจาย +5VDC/500mA จากพอรต USB 

และจากแหลงจาย +5VDC จากภายนอกไดดวย พรอม LED Power แสดงสถานะของแหลงจาย 

 มีวงจร External Reset แบบ RC Reset และ Switch Reset พรอมภายในบอรด 

 ข้ัวตอใชงานวางตัวบน Pin Header ระยะหาง 2.54mm(100mil) ขนาด 28 Pin (ดานละ14Pin) 

ระยะหาง 600mil(1.5cm) งายตอการนําไปตอประยุกตใชงาน และ ขยายวงจร I/O สามารถใชกับ 

Project Board และ PCB เอนกประสงคไดโดยงาย 

 มีข้ัวตอ USB สําหรับเช่ือมตอส่ือสารกับคอมพิวเตอร PC ผาน USB Bridge ของ FTDI ในรูปแบบ

ของการส่ือสารอนุกรม RS232 สําหรับใชงานส่ือสารและ Download  Code ใหกับ MCU ในบอรด 

 มีข้ัว AVRISP แบบ IDE 10PIN สําหรับใช Download โปรแกรมใหกับ MCU ภายในบอรดในกรณี

ไมตองการใชการพัฒนาโปรแกรมผานทาง Boot Loader 

 มี LED แสดงสถานะ โดยตอกับ PB5 ของ AVR (Digital-13 ของ Arduino Project) สําหรับใชเปน

อุปกรณทดลองการทํางานอยางงาย 
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รูปแสดง ลักษณะของบอรด ET-EASY168 STAMP  



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -4- WWW.ETT.CO.TH 

 

AVR Arduino Pin ET-EASY168 STAMP Pin Arduino AVR 
PD0 Digital-0 1 28 +5V(+Vin) +5V(+Vin) 

PD1 Digital-1 2 27 +VCC(+5V) +VCC(+5V) 

PD2 Digital-2 3 26 RESET# RESET(PC6) 

PD3 Digital-3 4 25 Analog-0 PC0/ADC0 

PD4 Digital-4 5 24 Analog-1 PC1/ADC1 

PD5 Digital-5 6 23 Analog-2 PC2/ADC2 

PD6 Digital-6 7 22 Analog-3 PC3/ADC3 

PD7 Digital-7 8 21 Analog-4 PC4/ADC4 

PB0 Digital-8 9 20 Analog-5 PC5/ADC5 

PB1 Digital-9 10 19 Analog-6 ADC6 

PB2 Digital-10 11 18 Analog-7 ADC7 

PB3 Digital-11 12 17 +VCC(+5V) +VCC(+5V) 

PB4 Digital-12 13 16 +AREF +AREF 

GND GND 14  15 Digital-13 PB5 
 

ตารางแสดง การจัดสรรขาสัญญาณของบอรด ET-EASY168 STAMP 
 

 
 

AVR Arduino Pin AVRISP Pin Arduino AVR 

PB3 Digital-11 MOSI +VCC +VCC +VCC 

- - NC GND GND GND 

RES# RES# RES# GND GND GND 

PB5 Digital-13 SCK GND GND GND 

PB4 Digital-12 MISO 
 

GND GND GND 

AVRISP 
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หนาที่ของขาสัญญาณในการใชงานแบบ “Arduino Project” 
• +5V(+Vin) เปนขาสําหรับใชเปนจุดรับแรงดันขนาด +5VDC จากภายนอกเพื่อใชเปนแหลงจาย

ไฟเล้ียงใหกับบอรด 

• +VCC(+5V) เปนขาแหลงจายไฟจุดเดียวกนักับที่ปอนใหกับ +VCC ของ MCU ซึ่งจุดนี้จะรับ

แรงดันมาจาก 2 แหลง ดวยกันคือ ขารับแรงดัน +5V(+Vin) จากขา 28 ของบอรด และ จากขา 

+VUSB(+5V) จากข้ัว USB ของบอรด โดยมี Diode ปองกันการยอนกลับของแรงดันไวแลว 

• +AREF เปนขาสําหรับรับสัญญาณแรงดันอางอิง (Analog Reference) ใหกับวงจร Analog Input 

ในกรณีตองการใชแรงดันอางอิงจากภายนอก 

• RESET# เปนขาสัญญาณ RESET ของ CPU ทํางานที ่Logic “0”  

• Digital[0..13] เปนขา I/O แบบ Digital สามารถใชงานเช่ือมตอกับสัญญาณ Logic TTL (5V) ตางๆ 

• Analog[0..7] เปนขา Input แบบ Analog สามารถรับ Input แบบ Analog 0..+5V 

 

หนาที่ของขาสัญญาณในการใชงานแบบ “AVR Micro Controller” 
• +5V(+Vin) เปนขาสําหรับใชเปนจุดรับแรงดันขนาด +5VDC จากภายนอกเพื่อใชเปนแหลงจาย

ไฟเล้ียงใหกับบอรด 

• +VCC(+5V) เปนขาแหลงจายไฟจุดเดียวกนักับที่ปอนใหกับ +VCC ของ MCU ซึ่งจุดนี้จะรับ

แรงดันมาจาก 2 แหลง ดวยกันคือ ขารับแรงดัน +5V(+Vin) จากขา 28 ของบอรด และ จากขา 

+VUSB(+5V) จากข้ัว USB ของบอรด โดยมี Diode ปองกันการยอนกลับของแรงดันไวแลว 

• +AREF เปนขาสําหรับรับสัญญาณแรงดันอางอิง (Analog Reference) ใหกับวงจร Analog Input 

ในกรณีตองการใชแรงดันอางอิงจากภายนอก 

• RESET# เปนขาสัญญาณ RESET ของ CPU ทํางานที ่Logic “0”  

• PB[0..5]  เปนขา I/O แบบ Digital สามารถใชงานเชื่อมตอกับสัญญาณ Logic TTL (5V) ตางๆ 

• PD[0..7]  เปนขา I/O แบบ Digital สามารถใชงานเชื่อมตอกับสัญญาณ Logic TTL (5V) ตางๆ 

• PC[0..5] เปนขา I/O ซึ่งสามารถกําหนดใหเปนไดทั้ง Digital และ Analog Input 

• ADC6,ADC7 เปนขา Input แบบ Analog สามารถรับ Input แบบ Analog 0..+5V 
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การพัฒนาโปรแกรมของบอรด ET-EASY168 STAMP 
 ในการพัฒนาโปรแกรมของบอรด ET-EASY168 STAMP นั้น ผูใชสามารถเลือกใชวิธีการพัฒนา

โปรแกรมได 2 รูปแบบดวยกัน คือ  

• AVR Micro Controller เปนการพัฒนาโปรแกรมตามรูปแบบของ AVR Micro Controller ปรกติ 

ซึ่งสามารถเลือกใชโปรแกรมภาษาใดๆก็ไดที่รองรับการใชงานรวมกับ AVR เบอร ATmega168 ซึ่ง

ผูใชสามารถเลือกใชโปรแกรมในการพัฒนาไดตามความถนัด เชน ภาษาเบสิก BASCOM-AVR 

หรือ ภาษาซี เชน Code Vision และ WinAVR เปนตน 

• Arduino Project เปนการพัฒนาโปรแกรมโดยใชโปรแกรมและชุดคําส่ังในการเขียนโปรแกรมดวย

ภาษาซี (C++) ของ “Arduino Project” ซึ่งเปนโครงการพัฒนาไมโครคอนโทรลเลอร AVR แบบ 

Open Source ซึ่งกําลังไดรับความนิยมอยางแพรหลาย เนื่องจากเปนโครงการที่เปดเผยทั้ง 

Source Code ในการพัฒนาใหทั้งหมดและยังมีตัวอยางโครงงานพรอมตัวอยางโปรแกรมการ

ทดลองตางๆแจกจายใหผูสนใจนํามาใชศึกษา เรียนรูและทดลอง ไดฟรี โดยไมเสียคาใชจายใดๆ

ผูสนใจสามารถเขาไปคนหารายละเอียดตางๆของ Arduino Project นี้ได http://www.arduino.cc/ 

 

******************************************************************************** 
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การติดต้ัง Driver ของ USB Bridge ของบอรด ET-EASY168 STAMP 
 บอรด ET-EASY168 STAMP จะใชชิพ USB Bridge ของ FTDI เปนตัวกลางในการเชื่อมตอกับ

คอมพิวเตอร PC โดย USB Bridge ของ FTDI จะทําหนาที่เปนตัวกลางในการเชื่อมตอและติดตอส่ือสาร

ระหวางเคร่ืองคอมพิวเตอร PC กับ MCU ATmega168 ของบอรด ET-EASY168 STAMP ในรูปแบบของ

พอรตอนุกรม (Visual Com Port) โดยโปรแกรม Application ตางๆที่ทํางานอยูบนคอมพิวเตอร PC รวมทั้ง

โปรแกรม Arduino จะมองเห็น พอรต USB ที่เช่ือมตอกับบอรด ET-EASY168 STAMP เปนพอรตส่ือสาร

อนุกรม (Com Port) ชองหนึ่งเทานั้น ซึ่งถาเคร่ืองคอมพิวเตอรของผูใชเคยทําการติดต้ัง Driver สําหรับ USB 

Bridge ของ FTDI ไวกอนแลว เมื่อทําการเช่ือมตอสาย USB ของบอรด ET-EASY168 STAMP เขากบั USB 

HUB ของเคร่ืองคอมพิวเตอร PC แลว Windows จะทําการติดต้ัง Driver ใหเองโดยอัตโนมัติ แตถาเคร่ือง

คอมพิวเตอร PC ยังไมเคยติดต้ัง Driver ของ FTDI ไวกอนก็จะตองทําการติดต้ัง Driver ใหกับบอรดให

เรียบรอยเสียกอนซึ่งมีลําดับข้ันตอนดังนี้ 

1. เตรียมแผน CD ROM ที่บรรจุ Driver ของ FTDI ไวใหพรอม หรือ ในกรณีที่ผูใชไดทําการติดต้ัง

โปรแกรมของ Arduino ไวเรียบรอยแลว ภายในโฟลเดอรของโปรแกรม Arduino ก็จะมี Driver ของ 

FTDI จัดเตรียมไวใหเรียบรอบแลว โดยจะอยูที่ “C:\arduino-0012\drivers\FTDI USB Drivers\”  

2. ทําการเสียบสาย USB ของบอรด ET-EASY168 STAMP เขากับพอรต USB HUB ของเคร่ือง

คอมพิวเตอร PC ซึ่ง Windows จะตรวจพบอุปกรณใหม โดยเปน “FT232R USB UART” และ 

แจงใหผูใชทําการติดต้ัง Driver ใหกับอุปกรณ ดังรูป 
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3. ใหเลือก Install from list or specific location(Advanced) แลวเลือก Next ซึ่ง Windows ก็จะแจง

ใหผูใชระบุตําแหนงโฟลเดอรที่บรรจุไฟล Driver ของ FTDI ไว ก็ใหเลือกที่ Browse และเลือกไปยัง 

Drive และ โฟลเดอรที่เก็บไฟล Driver ไว ซึ่งถาผูใชไดทําการติดต้ังโปรแกรมของ Arduino ไวแลว ก็

ใหเลือกไปที่ “C:\arduino-0012\drivers\FTDI USB Drivers” แลวเลือก Next ดังรูป  
 

 
 

↓ 
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4. ในข้ันตอนนี้โปรแกรม Windows จะทําการคนหาและติดต้ัง Driver ใหกับอุปกรณ ใหรอสักครูจน

การทํางานเสร็จเรียบรอย แลวเลือก Finish ดังรูป 
 

 
 

↓ 
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5. หลังจากทําการติดต้ัง Driver ของฮารดแวรเรียบรอยแลว Windows ก็จะตรวจพบวามีอุปกรณใหม

ถูกเช่ือมตออยู โดยเปนอุปกรณประเภท “USB Serial Port” และแจงใหผูใชทําการติดต้ัง Driver 

ใหกับอุปกรณใหมที่ระบุเปน “USB Serial Port” อีกคร้ังหนึ่ง ซึ่งก็ใหเลือกระบุตําแหนงโฟลเดอรที่

เก็บไฟล Driver ไว ซึ่งใหเลือกเหมือนข้ันตอนในหัวขอที่ 3 ดังรูป 
 

 
 

↓ 
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6. ในข้ันตอนนี้โปรแกรม Windows จะทําการคนหาและติดต้ัง Driver ใหกับอุปกรณ ใหรอสักครูจน

การทํางานเสร็จเรียบรอย แลวเลือก Finish ดังรูป 
 

 
 

↓ 
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7. หลังจากทําการติดต้ัง Driver เรียบรอยแลว ก็สามารถใชงานอุปกรณไดแลว แตเพื่อความถูกตองใน

คร้ังแรกนี้ควรตองเขาไปทําการตรวจสอบและปรับแตงคาใหกับอุปกรณกอน โดยในข้ันตอนนี้ใหไป

ที่ “My Computer → Control Panel → System → Hardware → Device Manager” แลว

ทําการตรวจสอบที่ Ports (COM&LPT) แลวดูที่ชื่อของ “USB Serial Port” ซึ่งใหผูใชจดจํา

หมายเลขของ Com Port ของอุปกรณดังกลาวไว เพื่อใชอางอิงถึงในการเรียกใชงาน ดังรูป 
 

 
 

8. ในข้ันตอนนี้ใหคลิกเมาสที่เคร่ืองหมาย (+) หนาหัวขอ Ports(COM&LPT) แลวมองหาอุปกรณที่ชื่อ 

“USB Serial Port” ตามที่เราไดทําการติดต้ัง Driver ไวเรียบรอยแลว หรือ ถาไมแนใจวาอุปกรณ

ดังกลาวใชอุปกรณที่เปนของบอรด “ET-EASY168 STAMP” หรือไม ใหทดสอบดวยการถอดสาย 

USB ออก รายช่ืออุปกรณดังกลาวจะตองหายไป แตเมื่อเสียบสาย USB กลับเขามาใหม รายช่ือ

ของอุปกรณดังกลาวก็จะตองปรากฏใหเห็นอีกคร้ัง ถาทุกอยางถูกตอง ก็ใหทําการคลิกเมาสที่ Tab 

รายช่ือของอุปกรณดังกลาว เมื่อปรากฏหนาตาง USB Serial Port  Properties ข้ึนมาแลวใหเลือก

ที่ Port Setting แลวเลือก Advance เพื่อเขาไปกําหนดคาใหกับอุปกรณใหเรียบรอย ดังนี้ 

a. USB Transfer Size →  Receive (Bytes) ใหกําหนดเปน 256 

b. USB Transfer Size → Transmit (Bytes) ใหกําหนดเปน 128 

c. BM Option → Latency Timer (mSec)  ใหกําหนดเปน 1 
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↓ 
 

 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -14- WWW.ETT.CO.TH 

 

การพัฒนาโปรแกรมของ ET-EASY168 STAMP แบบ Arduino Project 
 

 

 ตามปรกติแลวบอรด ET-EASY168 STAMP จะทําการ ติดต้ังโปรแกรม Bootloader ไวใหเรียบรอย

แลว โดยใช Bootloader ชื่อ “BOOT_EASY168_AUTO_16MHZ.HEX” ซึ่งเปน Bootloader ที่ทางทีมงาน 

อีทีที ไดนําตนฉบับจาก Arduino มาปรับปรุงเงื่อนไขการทํางานใหม เพื่อใหการทํางานสอดคลองกับระบบ

ฮารดแวรของบอรด ET-EASY168 STAMP ไดดียิ่งข้ึน โดยโปรแกรม Bootloader นี้จะใชสําหรับ

ติดตอส่ือสารเพื่อส่ัง Upload Code จากคอมพิวเตอร PC ใหกับ MCU ในบอรดทํางาน โดยไมตองใชเคร่ือง

โปรแกรมภายนอกใหยุงยาก ซึ่ง คุณสมบัติของ Bootloader ที่ทาง อีทีที ปรับปรุงเพิ่มเติมข้ึน มีคุณสมบัติ

การทํางานเปนดังนี้ 
 

- ส่ือสารกับโปรแกรมภายนอกดวย Protocol แบบ STK500 (STK500V1) 

- ใชความเร็ว Baudrate 19200 โดยใชความถี่ XTAL 16 MHz 

- โปรแกรม Bootloader มีขนาด 2KByte ทํางานที่ตําแหนง 0x3800-0x3FFF 

- ใช LED ที่ตอกับขา Digital-13(PB5) เปนตัวแสดงสถานะในขณะที่ Bootloader ทํางาน  

- โปรแกรมใน Bootloader จะทํางานโดยอัตโนมัติทุกคร้ังหลังการรีเซ็ต โดย MCU จะเร่ิมตนทํางาน

ใน Bootloader นี้กอนเสมอ ซึ่งถาไมมีการติดตอสื่อสารจากโปรแกรม Arduino ภายในเวลา

ประมาณ 3 วินาที MCU ก็จะออกจากการทํางานใน Bootloader เพื่อไปเร่ิมตนทํางานตามคําส่ังที่

เปนของผูใช โดยอัตโนมัติ โดยในขณะที่ Bootloader ทํางาน ตอนเร่ิมตนจะเห็น LED ที่ตอไวกับ

ขาสัญญาณ Digital-13(PB5) กระพริบ 3 คร้ัง แลวติดคาง เพื่อรอการติดตอส่ือสารจากโปรแกรม

สําหรับส่ังใหทําการ Upload Code ใหกับ MCU ซึ่งถาไมมีการติดตอส่ือสารจากโปรแกรมของ 

Arduino ภายในระยะเวลาประมาณ 3 วินาที โปรแกรมก็จะกระโดดไปทํางานในตําแหนงเร่ิมตนที่

เปนสวนของโปรแกรมที่ผูใชเขียนข้ึนทันที  
 

นอกจากนี้แลวผูใชยังสามารถเปลี่ยนไปใชโปรแกรม Bootloader รุนมาตรฐาน ตามแบบโปรแกรม ของ 

Arduino ไดอีกดวย โดยใชโปแกรม Bootloader ที่ชื่อ “ATmegaBOOT_168_diecimila.hex” โดยไฟล

ดังกลาวจะถูกบรรจุไวใน Drive และโฟลเดอรเดียวกันกับที่ผูใชไดทําการติดต้ังโปรแกรมของ Arduino ไว

แลวคือ “C:\arduino-0012\hardware\bootloaders\atmega168\ATmegaBOOT_168_diecimila.hex” 
 

 แตอยางไรก็ตามในการทีจ่ะสามารถทําการติดต้ังโปรแกรม Bootloader Code ใหกบั MCU ไดนั้น 

ผูใชจําเปนตองมีเคร่ืองมือสําหรับทําหนาที่ Program Code ใหกับ MCU อยูดวย โดยใชเคร่ืองโปรแกรมที่มี

ข้ัวตอตามมาตรฐานของ “AVRISP” ของ ATMEL แบบ IDE 10 PIN ไดทันที โดยวิธีการใหศึกษาเพิม่เติม

จากหัวขอ “การโปรแกรม Bootloader ใหกับบอรด ET-EASY168 STAMP” ในตอนทายของคูมือนี ้
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การติดต้ังโปรแกรม Arduino  
 หลังจากที่เราไดทําการติดต้ัง USB Driver ใหกับบอรดเปนที่เรียบรอยแลว ก็เปนอันเสร็จส้ินข้ันตอน

ของการเตรียมการแลว ลําดับข้ันตอนตอจากนี้เปนตนไป ก็เปนเร่ืองของการใชงาน การเขียนโปรแกรม และ

การศึกษาเรียนรูตางๆตามความตองการแลว แตกอนอ่ืนเราจะตองทําการติดต้ังโปรแกรมของ Arduino เพื่อ

ใชเปนโปรแกรมสําหรับศึกษาเรียนรู ซึ่งมีลําดับข้ันตอนดังตอไปนี้ 

1. ทําการ unzip ไฟลชื่อ “arduino-0012-win.zip” ไวในฮารดดิสก ซึ่งขอแนะนําใหทําการ unzip ไวที่ 

Root นอกสุดใน Drive C โดยหลังจากทําการ unzip เรียบรอยแลวจะไดโปรแกรมอยูที่ 

“c:\arduino-0012” 

2. ทําการส่ัง Run โปแกรม “arduino.exe” จะไดผลดังรูป 
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3. ในคร้ังแรกของการเรียกใชงานโปรแกรม ใหทําการกําหนดระบบฮารดแวรที่จะใชงานกับโปรแกรม

ของ Arduino ใหเรียบรอยเสียกอน เนื่องจากในปจจุบันนี้ มีการออกแบบวงจรและสรางฮารดแวร

บอรดแบบตางๆสําหรับนํามาใชงานรวมกับโปรแกรมพัฒนาของ Arduino ไวมากมายหลายรุน โดย

ในกรณีของบอรด ET-EASY168 STAMP ใหทําการเลือกกําหนดชื่อบอรดเปน “Diecimila” โดย

คลิกเมาสที่ “Tools → Board → Arduino Diecimila”  ดังรูป 
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4. เลือกกําหนดหมายเลขพอรต สําหรับติดตอส่ือสารกับบอรด ใหตรงกับหมายเลข Comport ที่ไดทํา

การติดต้ัง Driver ของ USB ไวในตอนแรก เชน ถาตอนติดต้ัง Driver ของ USB แลวไดหมายเลข 

Comport เปน COM5 ใหคลิกเมาสที่ Tools → Serial Port → COM5  ดังรูป 
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5. ทดสอบเขียนโปรแกรม โดยคลิกเมาสที่ File → New แลวพิมพโปรแกรมทดสอบ หรืออาจใชการ

ส่ังเปดไฟลตัวอยางที่สรางไวแลวข้ึนมาแทนก็ได โดยในที่นี้ขอแนะนําใหทดสอบดวยโปรแกรมไฟ

กระพริบ โดยใหเลือก “File → sketchbook → Examples → Digital → Blink” ซึ่งจะไดดังรูป 
 

 
 

 

int ledPin = 13;              
 

void setup()                
{ 
  pinMode(ledPin, OUTPUT);   
} 
 

void loop()                  
{ 
  digitalWrite(ledPin, HIGH);   
  delay(1000);                   
  digitalWrite(ledPin, LOW);   
  delay(1000);                   
} 
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6. ส่ังแปลโปรแกรมโดยคลิกเมาสที่  “Sketch →  Verify/Compile” ดังตัวอยาง 
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7. ส่ัง Download Code ใหกับบอรด โดยคลิกเมาสเลือกที่ “File → Upload to I/O Board” แลวรอ

สักครูจนโปรแกรมทํางานเสร็จ ซึ่งควรไดผลดังรูป 

 

 
 

8. หลังจากที่ทําการ Upload Code ใหกับบอรดเปนที่เรียบรอยแลว บอรดก็จะเร่ิมตนทํางานตาม

คําส่ังที่เขียนไวในโปรแกรมทันที โดยจะสังเกตเห็น LED กระพริบ ติด และ ดับ สลับกันไปมา ดวย

ความเร็วประมาณ 1 วินาที ตลอดเวลา 
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การโปรแกรม Bootloader ใหกับบอรด ET-EASY168 STAMP 
 ตามปรกติแลวบอรด ET-EASY168 STAMP ไดทําการโปรแกรม Bootloader ไวใหเปนที่เรียบรอย

แลว ผูใชสามารถใชงานไดทันที่ แตอยางไรก็ตามในกรณีที่ตองการเปล่ียนแปลง Bootloader หรือ เกิด

ความผิดพลาดในการใชงาน จนทําให Bootloader เสียหายไป ผูใชก็ยังสามารถทําการ โปรแกรม 

Bootloader ใหกับบอรดไดใหม โดยบอรด ET-EASY168 STAMP ไดออกแบบ ใหมีข้ัวตอ AVRISP สําหรับ

ใชเปนชองทางในการโปรแกรม Code ใหกับ MCU ไดโดยตรง ดวยเคร่ืองโปรแกรมทุกรุนที่มีข้ัวตอ ตรงตาม

มาตรฐาน AVRISP ของ ATMEL ไดทันที โดยในที่นี้จะขอแสดงตัวอยาง วิธีการ โปรแกรม Bootloader โดย

ใชเคร่ืองโปรแกรม ของ อีทีที รุน “ET-AVR ISP USB V1.0” โดยใชโปรแกรม “AVR Studio 4” ของ 

ATMEL เปนตัวจัดการ ซึ่งมีลําดับข้ันตอนดังตอไปนี้ 
 

1. ตอสาย USB ใหกับบอรด ET-EASY168 STAMP ในกรณีตองการใชไฟเล้ียงจากพอรต USB หรือ 

จายไฟเล้ียง +5V ใหกับบอรดที่ขา 28(+5V) 

2. ตอสาย USB ใหกับเคร่ืองโปรแกรม ET-AVR ISP USB V1 พรอมทั้งตอสายแพร 10 Pin ระหวาง

ข้ัวตอของ AVRISP ของทั้ง 2 บอรดเขาดวยกัน 

3. ส่ัง Run โปรแกรม AVR Studio 4 ดังรูป 
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4. เลือกคลิกเมาสที่ Tools → Program AVR → Connect.. →  STK500 or AVRISP จากนั้นก็ให

เลือกหมายเลขของ Comport ที่เปนของเคร่ืองโปรแกรม ET-AVR ISP USB V1 ตามที่ลง Driver ไว

พรอมกับเลือก Connect (จากตัวอยางเปน Com9) ดังรูป 

 

 
 

↓ 
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5. หลังจากที่ทําการ Connect เรียบรอยแลวใหทดสอบการเช่ือมตอโดยเลือกที่ tab ของ Main พรอม

กับเลือกเบอรของ MCU เปน ATmega168 และเลือก Programming Mode and target Settings 

เปน ISP mode แลวทดสอบเลือก Read Signature ดู ซึ่งถาทุกอยางถูกตองควรไดผลดังรูป 

 

 
 

6. ใหเลือกไปที่ tab ของ Program พรอมทั้งเลือก ตัวเลือกตางๆดังนี้ 

• Device ใหเลือก Erase device before flash programming และ Verify device after 

programming 

• Flash ใหเลือก Input HEX File เปน BOOT_EASY168_AUTO_16MHZ.HEX จากนั้นให

เลือกที่ Program เพื่อส่ัง Program Bootloader ใหกับ MCU ซึ่งจะไดผลดังรูป 
 

 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -24- WWW.ETT.CO.TH 

 

7. หลังจากที่ทําการโปรแกรม Code ใหกับ MCU เรียบรอยแลว ใหเลือกมาท่ี Tab ของ Fuses เพื่อทํา

การสั่งโปรแกรม Fuse Bit ใหกับ MCU โดยใหเลือกกําหนดคาตัวเลือกดังนี้ 

 

• BOOTSZ ใหเลือกเปน Boot Flash size = 1024 word start address = $1C00 

• BOOTRST ใหเลือก Enable 

• SPIEN ใหเลือก Enable 

• SUT_CKSEL ใหเลือกเปน Ext.Crystal Osc 8.0MHz;Start-up time PWRDN/RESET : 

16K CK/14 ซึ่งเปนตัวเลือกดานลางสุด  

 

เมื่อเลือกตัวเลือกตางๆครบแลวจึงส่ัง Program ซึ่งควรไดผลดังรูป 

 

 
 

8. หลังจากทําการส่ัง program  Fuse Bit เรียบรอยแลว ใหเลือก Tab มาที่ LockBits แลวเลือกการ

Protect เฉพาะ Bootloader โดยเลือก BLB1 เปน LPM and SPM prohibited in Boot Section 

แลวส่ัง program เปนอันเสร็จส้ินกระบวนการ Program Bootloader 
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การโปรแกรม USB Bridge ของ FTDI ใหพอรต USB จายกระแสได 500mA 
 ตามปรกติแลว USB Bridge ของ FTDI เบอร FT232R จะถูกกําหนด Configuration คาใหใช

แหลงจายจากพอรต USB โดยตามคามาตรฐานของ USB Driver ของ FTDI นั้นจะรองขอกระแสไฟ ไปยัง 

USB Host เพียงแค 90mA เทานั้น ซึ่งตามมาตรฐานแลวพอรต USB สามารถจายกระแสไฟใหกับอุปกรณที่

เชื่อมตอดวยสูงสุดที่ 500mA ซึ่งเพื่อความสะดวกในการทดลองตางๆ ดวยบอรด ET-EASY168 STAMP ใน

กรณีที่ยังไมไดเชื่อมตอกับอุปกรณภายนอกมากมายนัก(ใชกระแสไมเกิน 500mA) เราก็สามารถเขาไปส่ัง

แกไขเปล่ียนคา Configuration ของ USB HUB เพื่อใหจายกระแสออกมาใหครบ 500mA ไดดวย ซึ่งจะทํา

ใหเกิดความสะดวกและคลองตัวในการทดลองตางๆมากข้ึนดวย แตอยางไรก็ตามถาหากวาผูใช ทําการตอ

ทดลองกับ เคร่ืองคอมพิวเตอรแบบ Notebook ที่ใชกระแสไฟจาก Battery หรือมีการเช่ือมตอบอรดทดลอง

กับอุปกรณที่ใชกระแสไฟมากๆ ก็ควรจัดหาแหลงจายไฟภายนอกเพ่ือจายใหกับบอรดเองจะเหมาะสมกวา 

ขอแนะนํานี้เปนการแนะนําสําหรับผูที่ตองการทดสอบการทํางานหรือทดลองเขียนโปรแกรมกับบอรด แบบ

ที่ไมไดเนนการเช่ือมตอกับอุปกรณภายนอกมากมายนัก เชน ทดสอบไฟกระพริบ โดยใช LED เปนอุปกรณ

การทดลอง หรือ การรับสงขอมูลกับพอรตส่ือสารอนุกรม เปนตน  

 โดยการแกไขคา Configuration ของ USB Bridge ของ FTDI จะใชโปรแกรม “MProg.exe” เปน

ตัวจัดการโดยมีลําดับข้ันตอนดังตอไปนี้ 

1. ตอสาย USB ของบอรด ET-EASY168 STAMP เขากับพอรต USB แลวส่ัง Run Program MProg 

ซึ่งจะไดผลดังรูป 
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2. ส่ังโปรแกรม “mProg” คนหา  USB Bridge ที่ติดต้ังไวในเคร่ือง โดยเลือกที่เมนู  Device → Scan 

ซึ่งควรไดผลดังรูป 
 

 
   

3. ส่ังอานคา Configuration เดิมของ FTDI ออกมา โดยเลือกที่ Tools → Read and parse ซึ่งควร

ไดผลดังรูป 
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4. ใหทําการแกไขคา Configuration ในสวนของ USB Power Options ใหเลือกเปน Bus Powered 

และกําหนดคา Max Bus Power จากเดิมที่กําหนดไวที่ 90 milli Amps เปน 500 milli Amps สวน

คา Configuration อ่ืนๆไมตองเปลี่ยนแปลง จากนั้นใหทําการบันทึกคา Configuration ไวในเคร่ือง

กอนโดยใหเลือกที่ File → Save As.. ดังรูป 
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5. ส่ังโปรแกรมคา Configuration คืนใหกับ FTDI โดยใหเลือกที่ Device → Program แลวรอจน

โปรแกรมทํางานเสร็จ หลังจากนั้นให ถอดสาย USB ออกแลวเสียบกลับเขาไปใหม USB ก็จะ

ทํางานตามคา Configuration ใหมไดแลว 
 

 
↓ 
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การพัฒนาโปรแกรมของ ET-EASY168 STAMP แบบ AVR Microcontroller 
 

 ในกรณีที่ผูใชตองการที่จะพัฒนาโปรแกรมใหกับบอรด ET-EASY168 STAMP แบบปรกติ ใน

รูปแบบของไมโครคอนโทรลเลอร AVR ก็สามารถทําได โดยสามารถเลือกภาษาในการเขียนโปรแกรม ไดเอง 

ซึ่งในกรณีนี้ผูใชสามารถเลือกใชภาษาใดๆก็ไดที่รองรับการใชงานกับ MCU ตระกูล AVR เบอร 

ATmega168 โดย ผูใชงานสามารถบริหารจัดการระบบทรัพยากรตางๆที่อยูภายในตัว ATmega168 ไดเอง

ทั้งหมด โดยสามารถทําได 2 แนวทางคือ 

 

• การพัฒนาโปรแกรมโดยใชเครื่องโปรแกรมภายนอก ในกรณีนี้จะมีขอดีคือ ไมสูญเสีย

ทรัพยากรใดๆเลย ผูใชสามารถใชงานและกําหนดคุณสมบัติการทํางานของทรัพยากรตางๆที่มีอยู

ใน MCU ไดเอง ตามตองการ แตมีขอเสียคือ ตองมีเคร่ืองโปรแกรมภายนอก สําหรับทําหนาที่ 

โปรแกรม Code ใหกับ MCU โดยสามารถใชไดกับเครื่องโปรแกรมทุกรุนที่ รองรับการใชงานกับ 

MCU เบอร ATmega168 และมีข้ัวตอตามมาตรฐาน AVRISP ของ ATMEL 

 

• การพัฒนาโปรแกรมโดยใชงานรวมกับ Bootloader ในกรณีนี้จะมีขอดี คือ เมื่อทําการเขียน

โปรแกรมเสร็จแลวสามารถส่ัง Program Code ใหกับ MCU ผานทางโปรแกรม Bootloader ที่

ติดต้ังไวแลวไดทันที โดยไมตองใชเคร่ืองโปรแกรมภายนอก แตมีขอจํากัด คือ ตองเสียพื้นที่

หนวยความจํา Flash สําหรับเก็บ Code โปรแกรมไป 2KByte (0x3800 -0x3FFF) เพื่อใชติดต้ัง

โปรแกรม Bootloader ซึ่งตามปรกติแลวบอรด ET-EASY168 STAMP จะทําการ ติดต้ังโปรแกรม 

Bootloader ไปใหเรียบรอยแลว โดยในกรณีนี้ผูใชจะสามารถเขียนโปรแกรมใชงานไดทั้งหมด

จํานวน 14 Kbyte จากที่มีอยูทั้งหมด 16Kbyte โดยตองเขียนโปรแกรมใหมีตําแหนงการทาํงานของ 

Code อยูระหวางตําแหนงแอดเดรส 0x0000 ถึง 0x37FF (0x1C00 - 0x1FFF K Word) สวน 

SRAM,EEPROM และทรัพยากรอื่นๆที่มีอยูใน MCU ผูใชยังสามารถใชงานไดครบตามจํานวนที่มี

อยูในตัว MCU ทุกประการ 
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ตัวอยางการพัฒนาโปรแกรมดวย WinAVR โดยใชงานรวมกับ Bootloader 
ตัวอยางที่จะแสดงตอไปนี้จะแสดงใหเห็นวิธีการพัฒนาโปรแกรมใหกับ ATmega168 ดวยภาษาซี 

โดยใชโปรแกรม AVR Studio4 ของ ATMEL รวมกับ Compiler ภาษาซีของ WinAVR 

1. ส่ัง Run Program AVR Studio4 
 

 
 

2. ส่ังสราง project ใหม โดยเลือกที่ project → New project จากนั้นเลือกกําหนดตัวเลือกตางๆ

ใหกับโปรแกรมดังนี้ 

• Project type เลือกกําหนดเปน AVR GCC 

• Location สําหรับบันทึก project ใหระบุตําแหนง Folder ที่ตองการใชบันทึกไฟล และ Code

ตางของ project ในตัวอยางกําหนดไวที่ “C:\test_easy168\” 

• Poject name ใหกําหนดช่ือ project ตามตองการในตัวอยางกําหนดเปน “led_blink” และให

เลือก Create initial file ไวดวย ซึ่งเมื่อเราทําการกําหนดช่ือ project name เสร็จแลว โปรแกรม

จะสรางไฟล ที่มีชื่อเดียวกันกับ project name ใหเองโดยอัตโนมัติ 
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3. เมื่อกําหนดคาตัวเลือกตางๆ ใหกับโปรแกรมเรียบรอยแลว ใหเลือกที่ Next แลวกําหนดคาใน 

Debug platform เปน AVR Simulator และเลือก Device เปน ATmega168 ดังรูป 

 

 
 

↓ 
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4. ใหพิมพคําส่ังของโปรแกรมสําหรับทดสอบการทํางาน ในหนาตาง Text Editor ของโปรแกรม โดย

ในที่นี้จะทดสอบดวย Codeโปรแกรม สําหรับทําหนาที่เปนไฟกระพริบที่ PB5 ซึ่งเปน LED ที่ติดต้ัง

ไวบนบอรด ET-EASY168 STAMP อยูแลว ดังตัวอยาง 

 
/******************************/ 
/* Program Test LED Blinking  */ 
/* Board : ET-EASY168 STAMP   */ 
/* MCU   : ATmega168          */ 
/* X-TAL : 16.00MHz           */ 
/******************************/ 
 
#include <avr/io.h> 
#define  F_CPU 16000000UL   // X-TAL = 16 MHz 
#include <util/delay.h> 
 
#define PORT_LED PORTB  // Port Drive LED = PB 
#define DIR_LED  DDRB  // Port Direction  
#define LED 5                  // Pin Drive LED = PB5 
 
/********************/ 
/* Delay 1..65535 mS */ 
/********************/ 
void delay_ms(unsigned int time) 
{ 
  while(time-->0) 
  { 
    _delay_ms(1.0); 
  } 
} 
 
 
int main (void) 
{ 
  DIR_LED  |= (1<<LED);  // Pin Drive LED = Out 
   
  while(1) 
  { 
    PORT_LED &= ~(1<<LED);  // Pin LED = 0 
 delay_ms(200); 
 
    PORT_LED |=  (1<<LED); // Pin LED = 1 
 delay_ms(200); 
  } 
} 
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5. หลังจากพิมพ Code โปรแกรมเสร็จแลวใหส่ังแปลโปรแกรม โดยเลือกที่ build →rebuild all ซึ่ง

ผลจากการแปลคําส่ังจะไดเปน HEX File ที่มีชื่อเดียวกันกับ project ที่สรางไว ดังรูป 
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การส่ังโปรแกรม Hex Code ใหกับบอรด ET-EASY168 STAMP ผาน Bootloader 
 

 ในการพัฒนาโปรแกรมของ บอรด ET-EASY168 STAMP ในรูปแบบของ AVR Microcontroller 

นั้น หลังจากที่ทําการเขียนโปรแกรม และส่ังแปลคําส่ังจนได HEX File เรียบรอยแลวในการส่ัง Program 

HEX Code ที่ไดจากการแปลคําส่ังของโปรแกรมนี้ ผานทางโปรแกรม Bootloader ของบอรดนั้น ขอแนะนํา

ใหใชโปรแกรม AVRDude โดยใชงานผาน AVRDudeGUI ซึ่งมีข้ันตอนดังนี้ 

1. ทําการสรางโฟลเดอรชื่อ AVRDUDE ไวใน Drive C (“C:\AVRDUDE\”) จากน้ันใหทําการ Copy 

โปรแกรมของ avrdude และ avrdudeGUI ไวใน “C:\AVRDUDE\” โดยจะมีทั้งหมด 3 ไฟลดวยกัน

คือ avrdude.exe, avrdude.conf และ avrdudegui.exe  

2. ส่ัง Run Program AVRDude.EXE แลวเลือกที่ Tab ของ Configuration ใหเลือกกําหนดคาตางๆ 

ดังตอไปนี้ 

 
 

หมายเหตุ ถาหมายเลข Comport  มากกวา com8 ใหพิมพหมายเลข Comport ลงไปในชองรับคา

ของ –P Port ไดเอง เชน com9 แตถาหมายเลข Comport มีคาเปน 2 หลักให เพิ่มเคร่ืองหมาย “\\.\” 

นําหนาช่ือหมายเลข Comport ลงไปดวย เชน ถาใชกับ Com13 ก็ใหกําหนดเปน  “\\.\com13” เปนตน 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -35- WWW.ETT.CO.TH 

 

ใหทําการกําหนดคา Configuration ใหกับโปรแกรม AVRDudeGUI ดังนี้ 

• Location of avrdude ใหเลือกไปที่ชื่อและที่อยูของไฟล avrdude.exe ที่ไดติดต้ังไวตาม

ข้ันตอนที่ 1 ซึ่งก็คือ “C:\AVRDude\avrdude.exe” 

• -C Location of alternate configuration file ใหเลือกไปที่ชื่อและที่อยูของไฟล avrdude.conf 

ที่ไดติดต้ังไวตามข้ันตอนที่ 1 ซึ่งก็คือ “C:\AVRDude\avrdude.conf” 

• -p Device ใหเลือกเปน m168 

• -c Programmer ใหเลือกเปน stk500 

• -p Port ใหเลือกเปนหมายเลข Comport ตามที่ไดติดต้ัง Drive ของ USB(FTDI) ไว 

• -b Baudrate ใหเลือกกําหนดเปน 19200 

3. เปล่ียน Tab ไปที่ File แลวเลือกกําหนดสวนของ Flash โดยใหเลือก Write และ Verify พรอมทํา

กําหนดช่ือ HEX File ไฟล ที่ตองการจะโปรแกรม ซึ่งในที่นี้จะใช HEX File ที่ไดจากตัวอยางที่เขียน

ดวยภาษาซีของ WinAVR ซึ่งจะอยูใน “C:\test_easy\default\led_blink.hex” ดังรูป 
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4. เมื่อกําหนดคาตางๆใหกับโปรแกรมเรียบรอยแลว ใหเลือกที่ Execute ที่อยูใน Tab ของ Files  ซึ่ง

โปรแกรม avrdude จะเร่ิมตนทําการ โปรแกรม HEX File ใหกับบอรดทันที ใหรอจนเสร็จดังรูป 

 

 
 

5. หลังจากส่ังโปแกรมเสร็จใหรอสักครูประมาณ 3 วินาที บอรดจะเร่ิมตนทํางานทันที โดยจะเหน็ LED 

กระพริบ ติด และ ดับ สลับกันไปมาไมรูจบ ซึ่งถาตองการทดสอบการทํางานใหม ก็ใหลอง กด

สวิตช Reset ที่บอรด ซึ่งตอนเร่ิมตนจะเห็น LED กระพริบอยางเร็วจํานวน 3 คร้ังแลวติดคาง ซึ่ง

ชวงนี้เปนการทํางานของ MCU ตามโปรแกรมใน Bootloader ซึ่งเมื่อไมมีการติดตอส่ือสารเพื่อส่ัง

ใหโปรแกรมเขาทํางานในโหมด Program Code ของ Bootloader ภายในเวลา 3 วินาที MCU ก็จะ

จบการทํางานจากสวนของ Bootloader แลวกระโดดไปทํางานในสวนที่เปน Code ของผูใชเอง

ทันที ซึ่งหลังการรีเซ็ตทุกคร้ังจะเปนเชนนี้ไปตลอด โดยโปรแกรมที่เปนสวนของผูใชจะเร่ิมตนทาํงาน

หลังจากพนสภาวะรีเซ็ตไปแลวประมาณ 3 วินาที 
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